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1. Purpose and target group of this document

This document is intended for trained and certified service
persons, and describes advanced repair and testing procedures
for the SMART Digital XL dosing pump types DDA and DDE from
60 to 200 I/h.

expert knowledge and must only be carried out by
certified service persons authorised and qualified by
o Grundfos.

To identify your product see the type key and nameplate
description in the installation and operating instructions:

' The procedures described in this document require

Installation and operating instructions DDA
» http://net.grundfos.com/qr/i/98767821
Installation and operating instructions DDE
* http://net.grundfos.com/qr/i/98767824

2. Symbols used in this document

2.1 Hazard statements

WARNING

Indicates a hazardous situation which, if not avoided,
could result in death or serious personal injury.

The text accompanying the hazard symbol WARNING is
structured in the following way:

SIGNAL WORD

Description of hazard

Consequence of ignoring the warning.
- Action to avoid the hazard.

2.2 Notes

If these instructions are not observed, it may result in
malfunction or damage to the equipment.

S ~7
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Tips and advice that make the work easier.

2.2.1 Safety instructions

Important safety information as well as instructions on standard
service procedures for users can be found in the installation and
operating instructions of the product.

Installation and operating instructions DDA

* http://net.grundfos.com/qr/i/98767821

Installation and operating instructions DDE

* http://net.grundfos.com/qr/i/98767824

WARNING
Electric shock

Death or serious personal injury

- Before starting any work on the product, pull out
the mains plug, or switch off the power supply and
make sure it cannot be accidentally switched on.

- Keep liquids away from the power supply and
electrical components.

WARNING

Chemical hazard

Death or serious personal injury

- Before starting work on the pump, the system
must be pressureless.

% - Observe the material safety data sheet of the

dosing medium.

- Wear protective clothing (gloves and goggles)
when working on the dosing head, connections or
lines.

2.3 Diaphragm leakage

If the diaphragm leaks or is broken, dosing liquid escapes from
the drain opening in the dosing head.

In case of diaphragm leakage, the safety diaphragm protects the
pump housing against the ingress of dosing liquid.

When dosing crystallising liquids, the drain opening can be
blocked by crystallisation. If the pump is not taken out of
operation immediately, pressure can build up between the
diaphragm and the safety diaphragm. In consequence, dosing
liquid can penetrate the safety diaphragm and enter the pump
housing.

Most dosing liquids don't cause any danger when entering the
pump housing. A few liquids can cause a chemical reaction with
inner parts of the pump. In the worst case, this chemical reaction
can produce explosive gases in the pump housing.

WARNING

Danger of explosion, if dosing liquid has entered

the pump housing!

Death or serious personal injury

Operation with damaged diaphragms can lead to

dosing liquid entering the pump housing.

- In case of diaphragm leakage, immediately
separate the pump from the power supply!

- Make sure the pump cannot be put back into
operation by accident!

- Dismantle the dosing head without connecting the
pump to the power supply and make sure no
dosing liquid has entered the pump housing. If the
safety diaphragm is damaged, the pump cannot be
repaired and must be replaced.


http://net.grundfos.com/qr/i/98767821
http://net.grundfos.com/qr/i/98767821
http://net.grundfos.com/qr/i/98767824
http://net.grundfos.com/qr/i/98767824
http://net.grundfos.com/qr/i/98767821

3. Special tools

3.1 PC Tool for E-Products

The PC Tool for E-Products consists of hardware for pump
connection and software for your computer. It is required for
special service tasks, like firmware update and I/O board
calibration after replacement.

For analog output calibration, an additional multimeter is
required.

See section 6. Firmware update, analog I/O calibration,
store/restore settings

3.2 Profi tester

The Profi tester is a special tool to check the inputs and outputs
of Grundfos dosing pumps.

Product number: 99600937

3.3 Hydraulic test unit
The hydraulic test unit is used to check the hydraulic performance
of Grundfos dosing pumps.
Product number: 99600938

4. Replacing the 1/0 board

Before replacing the I/O board you can use the Profi tester to
check if it is damaged. See section 3.2 Profi tester.

1. Read section 2.2.1 Safety instructions.

2. Make the system pressureless.

3. Before starting any work on the product, pull out the mains
plug, or switch off the power supply and make sure it cannot
be accidentally switched on.

TMO7 3368 4918

Fig. 1 Replacing the I/O board - overview

Pos. Description

1/0 board

Plug connector position at backside of 1/0 board

3 Seal sticker

Position of 1/0 board cable connection at main circuit

4 board

5 Main circuit board

4. Remove the signal connections from 1/O board (1).
5. Remove seal sticker (3).

The grey area (2) indicates the position of the plug connector at
the backside of the I1/0 board. The grey area (4) indicates where
the cable is fixed at the main circuit board (5).

The cable from the I/O board to the main circuit
board is short. The cable is fixed permanently at the

' main circuit board.
Do not pull off the 1/0 board with force, otherwise the
([ main circuit board or the cable can be damaged. The
main circuit board and the cable cannot be repaired.
6. Remove the screws at the corners of 1/0 board (1).
— Wrench size: TORX PLUS 15 IP

7. Carefully pull off the right side of the /O board until you can
reach the plug connector (2) on the backside.

&
TMO7 3751 0219

! ?
Fig. 2 1/O board plug connector
8. To disconnect plug connector (2) proceed as follows:
— Press both latches (A) to unlock the plug.
— Carefully pull off the plug in the direction of the arrow (B).
9. Remove the 1/O board.
10. Connect the new 1/O board and install it in reverse order.
11. Tighten the screws using a torque wrench.
— Torque [Nm]: 1.7 (x 0.2)
12. Apply new seal sticker (3). Make sure the seal sticker covers
the side cover and the top left screw of the 1/0 board.
Perform 1/O board calibration
If an 1/0 board with analog connections was replaced, these
connections must be calibrated.
The number of analog connections depends on the pump type
and control variant.

Type Control variant Analog input  Analog output
AR YES YES
DDA
FCM YES YES
AR YES -
DDE B

Perform calibration according to section 6. Firmware update,
analog I/O calibration, store/restore settings.

English (GB)
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. Replacing the control cube

Read section 2.2.1 Safety instructions.
Make the system pressureless.

Before starting any work on the product, pull out the mains
plug, or switch off the power supply and make sure it cannot
be accidentally switched on.

TMO7 3369 4918

Fig. 3 Replacing the control cube - overview

Pos. Description
1 1/0 board
2 Plug connector position at backside of 1/0 board
3 Seal sticker
4 Position of 1/0 board cable connection at main circuit
board
5 Hall sensor plug connector position at main circuit board
6 Main circuit board
7 Side cover (mains cable and main circuit board are fixed
at this cover)
8 Control cube plug connector position at main circuit
board
9 Control cube
10 FlowControl or DLD signal connection (DDA only)
4. Remove the I/0 board (1) according to section 4. Replacing

the I/0 board.
Unplug FlowControl or DLD signal connection (10).

Carefully remove both protective caps on control cube (9)
using a thin flathead screwdriver.

Remove the screws from control cube (9).
— Wrench size: TORX PLUS 15 IP

For best access to main circuit board (6) turn control cube (9)
to the right.

The main circuit board (6) and the mains connection are fixed at
the side cover (7). There are several cables connecting the main

circuit board with other product components.

9.

The cables from the main circuit board to other
product components are short.
' Do not pull off the side cover with force, otherwise
the main circuit board or cables can be damaged.
([ J The main circuit board and cables (except control
cube cable) cannot be repaired.
Remove the screws from side cover (7).
— Wrench size: TORX PLUS 15 IP
— Leave the mains cable fixed at the side cover.

10. Carefully open the side cover (7) at the front side of the pump,

until you can reach the hall sensor plug connector (5) on the
main circuit board.

Fig. 4 Hall sensor plug connector

11. Carefully pull off the plug in the direction of the arrow. You ca
use a pair of needle-nosed pliers (A), if necessary. The plug i
not locked.

TMO07 3752 0219
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12. Carefully pull off side cover (7) until you can reach the control

cube plug connector (8) on the main circuit board.

Fig. 5 Control cube plug connector

13. To disconnect plug connector (8) proceed as follows:

— Press both latches (B) to unlock the plug.

— Carefully pull off the plug in the direction of the arrow (C).
14.Remove the control cube and gasket.

15. Carefully pre-bend the cable of the new control cube as
shown in detail (D).

Fig. 6 Control cube cable placement

16. Put the new control cube gasket in place.

17. Pass the cable through the control cube installation hole as
shown in detail (E).

18. Plug in the control cube cable at the main circuit board.
19.Plug in the hall sensor cable at the main circuit board.

TMO7 3757 0219
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20. Install the side cover again.

— Make sure that the cables do not have any sharp bends and
are not pinched.

— Make sure the I/O board cable is placed correctly for
subsequent I/O board installation.

21.Tighten the screws using a torque wrench.
— Torque [Nm]: 1.7 (£ 0.2)
22.Turn the control cube into the original position.
23.Mount the screws at the control cube.
24.Tighten the screws using a torque wrench.
— Torque [Nm]: 1.7 (£ 0.2)
25. Apply the protective caps.
26.Plug in the 1/0O board cable.
27.Install the 1/0 board again.
28. Tighten the screws using a torque wrench.
— Torque [Nm]: 1.7 (£ 0.2)
29.Plug in the FlowControl or DLD signal connection (10) again.

30. Perform electrical testing as described in 5.1 Dielectric
voltage withstand test.

31. Apply new seal sticker (3). Make sure the seal sticker covers
the side cover and the top left screw of the 1/0 board.

32. Perform hydraulic calibration. See installation and operating
instructions.

5.1 Dielectric voltage withstand test

WARNING
Electric shock
Death or serious personal injury
- The described procedures must only be performed
by a qualified electrician.
Test voltage: 1400 VAC or 2000 VDC

1. The test voltage must be applied between A and B which are
defined as:

— A: the short-circuited supply voltage connections
— B: all accessible conductive parts (potential earth at mains
cable, 1/0 board pins)
2. Raise the test voltage to the specified value within 5 seconds
and maintain it for minimum 2 seconds.

6. Firmware update, analog I/O calibration,
store/restore settings

6.1 Required equipment

The update & calibration process requires hardware to connect
the pump to a PC and software to perform the process.

6.1.1 Hardware for firmware update and analog I/O calibration

PC Tool Link

The package (part no. 96705378) contains the PC Tool Link,
various cables and a driver CD.

TMO7 4025 0719

Fig. 7 PC Tool Link

TMO7 4026 0719

Fig. 8 RS485 cable with screw terminal connector from PC
Tool Link package

Cable with female 5-pin M12 connector

To connect to the pump's GENIbus or analog output, a cable with
a female 5-pin M12 connector is required:

+ Part no. 96632921 (2m)
+ orpart no. 96632922 (5m)

TMO07 4027 0719

Fig. 9 Cable with female 5-pin M12 connector

sl ., Foranalog output calibration, the analog output and
—O— the GENIbus must be connected at the same time,
/\f™  so two cables are required in this case.

English (GB)
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6.1.2 Additional hardware for analog output calibration

To measure the actual current on the analog output, a multimeter
and a separate cable are required:

* The multimeter must have a DC current measuring range of 0-
200 mA or 0-400 mA.

* The multimeter must have an accuracy of current
measurement < 0.5 % Full Scale.

« The cable to connect the multimeter to the current output is
the same as the GENIbus cable. See fig. 9.

6.1.3 Establishing the GENIbus connection (for firmware
update, I/O calibration, store/restore settings)

1. Connect the female 5-pin M12 connector cable (see fig. 9.) to
the GENIbus connector of the pump.
Connector symbol on pump:

©

2. Connect the open ends of the 5-pin M12 connector cable to
the RS485 cable with screw terminal connector according to
this table:

RS485 cable with screw

5-pin M12 connector cable i
terminal connector

White Black
Blue Blue
Yellow — Green Yellow

6.1.4 Establishing the Analog output connection (for I/O
calibration)

1. Connect the female 5-pin M12 connector cable (see fig. 9.) to
the analog output connector of the pump.
Connector symbol on pump:

O

2. Connect the open ends of the 5-pin M12 connector cable to
the multimeter’s measuring leads according to this table:

5-pin M12 connector cable Measuring lead of

multimeter
Black DC mA input (+)
Yellow - Green GND (-)

6.1.5 Software

To perform the update, the installation of "PC Tool E-Products"

(part. no. 96562934) is required.

You can find the "PC Tool E-Products" page in GTI (Grundfos

Technical Information), where you can download the software and

find more information:

« http://insite.grundfos.com/notes/techmar/modifica.nsf/6e56a364
8c96eb09c1256¢13003b9509/860a2698d0d005f2¢c125788b00
479ba7

The "PC Tool E-Products" page can also be found this way:

* Grundfos Insite->Toolbox->GTI->Service Support Tools->
Grundfos PC Tools\PC Tool E-Product

COM port and user configuration
1. Start PC-Tool E-Products.

2. A message is displayed, indicating that no COM port is
selected.

— Click "OK" to select the correct COM port.

3. Click "Communication" in the next window and select the
suitable port:

Communication
Data log 5 Communication
Standard configuration Ot
Update controller ey
User Select interface PCTool-Link v
Select port &
Baud rate None
COM3
PWM connector COM6: PC Tool link
(O Network serial server k
Host name/IP addr.
Port
GP2P
Checksum CRC16 v
Product detection mode | connection request v
Show detection dialog
o
Advanced =
U S
Communication priofity | selected and direct connected ©
]
<
N~
Help Default oK Cancel Apply g
e

Fig. 10 COM port configuration

4. Switch user account for elevated permissions:
— Click "File" -> "Preferences..."
— Click "User" in the left window

— Make sure user "Firmware updater” is selected. If not, select
user "Firmware updater" and enter password

"Program@456":
Preferences
_Development loser |
Application Update User

Communication
Custom configuration
Data log Password:
Firmware Update
Standard configuration
Update controller

User

User:

Help Default 0K Cancel Apply

TMO7 4037 1020

Fig. 11 User configuration

5. Click "OK" and restart "PC-Tool E-Products".


http://insite.grundfos.com/notes/techmar/modifica.nsf/6e56a3648c96eb09c1256c13003b9509/860a2698d0d005f2c125788b00479ba7

6.2 Updating the firmware 6.3 Updating the GUI data

| |
_\ ’_ This kind of update does not affect the pump _\ '_ This kind of update does not affect the pump
AA settings. AA settings.
1. Make sure you have installed and configured the hardware 1. Make sure you have installed and configured the hardware
and software according to section 6.7 Required equipment. and software according to section 6.7 Required equipment.
2. Start "PC-Tool E-Products" and click the "Firmware update" 2. Start "PC-Tool E-Products" and click the "Firmware update"
button. button.
3. Click "Select file for PIC32 flash" and select the *.aes file in 3. Click "Select file for SPI flash" and select the *.bin file in the
the text box: text box:

Firmware Update Firmware Update

Firmware Update Firmware Update
(®) Application controller (®) Application controller

SDXL V2 0l.aes SDXL_V2_01.zes
(@) Select file for PIC32 flash (O select file for PIC32 flash

SD2_GuiRemote_V2_01.bin SD2 GuiRemote V2 01.bin
(D) select file for 5P1 flash (®) Select file for SPI flash

(O Mator controller (O Motor controller
Select file for Motor controller | SmartDigitalll_ramlib_bl_v02_01_00_ga¢ Select file for Motor controller | SmartDigitalll_ramlib_bl_v02_01_00_sa¢
o
S
Default boot & validate Motor calibration ~ Default boot & validate Maotor calibration
2
=}
<
Program Check for new SW version ’5 Program Chedk for new SW version
=
=
Fig. 12 Updating the firmware Fig. 13 Updating the GUI data

Power-off the pump. Power-off the pump.
Click "Program"”.

Power-on the pump. The update process starts.

Click "Program".
Power-on the pump. The update process starts.

No oM
N oA

After the update the pump restarts automatically. After the update the pump restarts automatically.

English (GB)
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6.4 Updating the motor controller
1

S~
(X

This kind of update does not affect the pump
settings.

\

The motor controller update is a three-step process:
* Update of motor controller firmware

» Default boot and validation

* Motor calibration

6.4.1 Updating the motor controller firmware

1.

Make sure you have installed and configured the hardware
and software according to section 6.7 Required equipment.

2. Power-on the pump.

3. Start "PC-Tool E-Products" and click the "Firmware update"

button.

4. Click "Motor controller" and select the *.xbin file in the text

box:

Firmware Update

Firmware Update
() Application contraller

Select file for PIC32 flash

select file for SPI flash

SDXL_VZ _0l.aes

SD2_GuiRemote_V2_01.bin

(®) Motor controller

Select file for Motor controller

Default boot & validate

Program

SmartDigitalll_ramlib bl V02 01 00 6a

Motor calibration

Check for new SW version

Fig. 14 Updating the motor controller firmware

5. Click "Program". The update process starts.
6.4.2 Default boot and validation

After the update of the motor controller firmware, click "Default
boot, Validate" (fig. 14) to load default parameters and to check if
the update process was successful.

In case of any error, repeat the motor controller firmware update.

6.4.3 Motor calibration

Perform a motor calibration, if the motor does not run properly
after the motor controller firmware update:

1. Start "PC-Tool E-Products" and click the "Firmware update"

button.

TMO7 4040 1020

2. Click "Motor calibration” (fig. 14). The motor runs at full speed

for some seconds.

3. After the motor calibration the motor stops and the pump

returns to normal operation.

6.5 Calibrating the analog input

1. Make sure you have installed and configured the hardware
and software according to section 6.7 Required equipment.

2. Start "PC-Tool E-Products" and click the "Custom
configuration [F7]" button:

[SMART Digital XL

“p -8 x

Custom configuration

‘nalog nput calbration

2. Click o calbrate anslog input

Calbrate analog input

Set20ma

4. Clc to send measured value to pump Send val

@ Veritr 5] @ Standard configuraton [ p——— ST @ Parameter it [

Messages: g 8T

Fig. 15 Opening the "Custom configuration” menu

TMO7 6164 1020

Make sure all cables are disconnected from the analog input

of the pump.

Click "Calibrate analog input". The calibration of the analog

input starts.

Custom configuration

Analog input calibration

1, Disconnect analog input

2. Click to calibrate analog input e
Analog output calibration
1. Click to set output to 20 mA
Set 20mA
2, Measure analog output current
3. Enter measured value and press Enter mA
4, Click to send measured value to pump Send value

Fig. 16 Calibrating the analog input

After the calibration the pump restarts automatically.

TMO7 4042 1020



6.6 Calibrating the analog output
Calibration of the analog output is a two-step process:
« Set the analog output to a reference value of 20 mA and

6.7 Storing and restoring the pump settings

Make sure you have installed and configured the hardware
and software according to section 6.7 Required equipment.

measure the actual current, using a multimeter (expected
range: 18-22 mA)

Write the measured value back into the pump, so the pump
can adjust its output accordingly.

6.6.1 Performing the calibration

1. Make sure you have installed and configured the hardware
and software according to section 6.7 Required equipment.
2. Start "PC-Tool E-Products" and click the "Custom

configuration [F7]" button:

[SMART Digital XL

“p -8 x

Dt Do Do |l remaere @
Custom configuration

‘nalog nput calbration

1. Discor

2. Clck to cabrate analog nput [

‘Analog output calibration
1. Clck o set output to 20mA
Set20ma
2. Measure analog output current

3. Enter measured value and press Enter

4. Clc to send measured value to pump Send value

() s @ Parameter st [F3]

nnnnnn ] 8T

©) s @) svssensaasare] (B) oom i

Messages:

Fig. 17 Opening the "Custom configuration" menu

3. Connect a multimeter to the analog output. Observe section

6.1.4 Establishing the Analog output connection (for I/O
calibration).

4. Click "Set 20 mA".
5. Read the measured current from the multimeter and enter the

value into the input field.
— Example: 19.85 mA.

Custom configuration

Analog input calibration
1. Disconnect analog input

2. dlick to calibrate analog input Callbrate analog Input

Analog output calibration
1. Click to set output to 20 mA
Set 20mA

2. Measure analog output current

3. Enter measured value and press Enter 19.85 mA

4. Click to send measured value to pump Send value

Fig. 18 Calibrating the analog output

— The pump adjusts the current output accordingly and
restarts.

TMO07 6164 1020

TMO07 4045 1020

6. Click "Send value" to send the multimeter value to the pump.

2. Start "PC-Tool E-Products" and click "Standard configuration

[F6]".
Storing settings
3. Click "Receive" to receive the current settings.

@ standard configuration
Search by Browse for Service Fles

My Fies &

#-fi] Program Fies (x86)

Receiving configuration. Please wat...
Current task: Receving...

Elapsed tme :  0:00:03

e e e

r A
@ Monitor [FS) @ Standard configuraton vs]-|@ Data log [F7]
| B A

Messages: e 8T

Fig. 19 Storing settings

After some seconds, a window with the binary data pops up.

1
_\ ’_ The displayed binary data looks like glyphs and
AA symbols, not like readable text.

4. Click "File > Save as..." to store the received settings.

5. Select a folder and enter a meaningful file name to store the

settings. The file name extension ".bin" is appended
automatically.

Restoring settings

@) standard configuration

Searchby Browse for Service Fies

My Fies. xF_(’Cj ~

5] Program Fies (x86)
£ SofPacDonnloadDrectory

rzfv
|
Ld

ootgrston fes

Fie Description  Date Path
|dda_params.bin Binary data  2019-02-11 13:24  C:\temp\ny_pump_settings.
L - — = = =
Found 1
Receive Mad to

@ Monitor [FS] @ Standard configuration [F6) @ Dataog [F7]

Messages:

Compare

—_— = ]

Fig. 20 Restoring settings

TMO7 4046 0719

TMO07 4047 0719

6. Browse the folder where the settings are stored. Then select

the .bin file.
7. Click "Send..." to transfer the settings to the pump.

— A message pops up asking if you want to send the
configuration data and stop the pump during transfer.

— Tick the check box and confirm the message with "Yes" to

stop the pump during the transfer.
The settings are transferred to the pump.
The settings are effective after the transfer has finished.

English (GB)
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7. Service kits and spare parts

For the full range of service kits and spare parts, see the service
kit catalogue:

* http://net.grundfos.com/qr/i/96488862_23
or the Grundfos Product Center:
* https://product-selection.grundfos.com

10


http://net.grundfos.com/qr/i/96488862_23
https://product-selection.grundfos.com

Argentina

Bombas GRUNDFOS de Argentina S.A.
Ruta Panamericana km. 37.500 Centro
Industrial Garin

1619 - Garin Pcia. de B.A.

Phone: +54-3327 414 444

Telefax: +54-3327 45 3190

Australia

GRUNDFOS Pumps Pty. Ltd.
P.O. Box 2040

Regency Park

South Australia 5942

Phone: +61-8-8461-4611
Telefax: +61-8-8340 0155

Austria

GRUNDFOS Pumpen Vertrieb Ges.m.b.H.
Grundfosstrae 2

A-5082 Grodig/Salzburg

Tel.: +43-6246-883-0

Telefax: +43-6246-883-30

Belgium

N.V. GRUNDFOS Bellux S.A.
Boomsesteenweg 81-83
B-2630 Aartselaar

Tél.: +32-3-870 7300
Télécopie: +32-3-870 7301

Belarus

Mpeactasutenscteo MPYHOPOC B
MwuHcke

220125, MuHck

yn. WadapHsiHckas, 11, od. 56, BLL
"MopTt"

Ten.: +7 (375 17) 286 39 72/73
dakc: +7 (375 17) 286 39 71
E-mail: minsk@grundfos.com

Bosnia and Herzegovina
GRUNDFOS Sarajevo

Zmaja od Bosne 7-7A,
BH-71000 Sarajevo

Phone: +387 33 592 480
Telefax: +387 33 590 465
www.ba.grundfos.com

e-mail: grundfos@bih.net.ba

Brazil

BOMBAS GRUNDFOS DO BRASIL

Av. Humberto de Alencar Castelo Branco,
630

CEP 09850 - 300

Sé&o Bernardo do Campo - SP

Phone: +55-11 4393 5533

Telefax: +55-11 4343 5015

Bulgaria

Grundfos Bulgaria EOOD
Slatina District

Iztochna Tangenta street no. 100
BG - 1592 Sofia

Tel. +359 2 49 22 200

Fax. +359 2 49 22 201

email: bulgaria@grundfos.bg

Canada

GRUNDFOS Canada Inc.
2941 Brighton Road
Oakville, Ontario

L6H 6C9

Phone: +1-905 829 9533
Telefax: +1-905 829 9512

China

Grundfos Alldos

Dosing & Disinfection

ALLDOS (Shanghai) Water Technology
Co. Ltd.

West Unit, 1 Floor, No. 2 Building (T 4-2)
278 Jinhu Road, Jin Qiao Export
Processing Zone

Pudong New Area

Shanghai, 201206

Phone: +86 21 5055 1012

Telefax: +86 21 5032 0596

E-mail: grundfosalldos-CN@grundfos.com

China

GRUNDFOS Pumps (Shanghai) Co. Ltd.
10F The Hub, No. 33 Suhong Road
Minhang District

Shanghai 201106

PRC

Phone: +86-21 6122 5222

Telefax: +86-21 6122 5333

COLOMBIA

GRUNDFOS Colombia S.A.S.

Km 1.5 via Siberia-Cota Conj. Potrero
Chico,

Parque Empresarial Arcos de Cota Bod.
1A.

Cota, Cundinamarca

Phone: +57(1)-2913444

Telefax: +57(1)-8764586

Croatia

GRUNDFOS CROATIA d.o.o.
Buzinski prilaz 38, Buzin
HR-10010 Zagreb

Phone: +385 1 6595 400
Telefax: +385 1 6595 499
www.hr.grundfos.com

GRUNDFOS Sales Czechia and
Slovakia s.r.o.

Capkovského 21

779 00 Olomouc

Phone: +420-585-716 111

Denmark

GRUNDFOS DK A/S

Martin Bachs Vej 3

DK-8850 Bjerringbro

TIf.: +45-87 50 50 50

Telefax: +45-87 50 51 51

E-mail: info_GDK@grundfos.com
www.grundfos.com/DK

Estonia

GRUNDFOS Pumps Eesti OU
Peterburi tee 92G

11415 Tallinn

Tel: + 372 606 1690

Fax: + 372 606 1691

Finland

OY GRUNDFOS Pumput AB
Trukkikuja 1

FI1-01360 Vantaa

Phone: +358-(0)207 889 500

France

Pompes GRUNDFOS Distribution S.A.
Parc d’Activités de Chesnes

57, rue de Malacombe

F-38290 St. Quentin Fallavier (Lyon)
Tél.: +33-4 74 82 15 15

Télécopie: +33-4 74 94 10 51

Germany

GRUNDFOS Water Treatment GmbH
Reetzstrale 85

D-76327 Pfinztal (Sollingen)

Tel.: +49 7240 61-0

Telefax: +49 7240 61-177

E-mail: gwt@grundfos.com

Germany

GRUNDFOS GMBH

Schliiterstr. 33

40699 Erkrath

Tel.: +49-(0) 211 929 69-0

Telefax: +49-(0) 211 929 69-3799
E-mail: infoservice@grundfos.de
Service in Deutschland:

E-mail: kundendienst@grundfos.de

Greece

GRUNDFOS Hellas A.E.B.E.

20th km. Athinon-Markopoulou Av.
P.O. Box 71

GR-19002 Peania

Phone: +0030-210-66 83 400
Telefax: +0030-210-66 46 273

Hong Kong

GRUNDFOS Pumps (Hong Kong) Ltd.
Unit 1, Ground floor

Siu Wai Industrial Centre

29-33 Wing Hong Street &

68 King Lam Street, Cheung Sha Wan
Kowloon

Phone: +852-27861706 / 27861741
Telefax: +852-27858664

Hungary

GRUNDFOS Hungéria Kift.
Topark u. 8

H-2045 Torokbalint,
Phone: +36-23 511 110
Telefax: +36-23 511 111

India

GRUNDFOS Pumps India Private Limited
118 Old Mahabalipuram Road
Thoraipakkam

Chennai 600 097

Phone: +91-44 4596 6800

Indonesia

PT. GRUNDFOS POMPA

Graha Intirub Lt. 2 & 3

JIn. Cililitan Besar No.454. Makasar,
Jakarta Timur

ID-Jakarta 13650

Phone: +62 21-469-51900

Telefax: +62 21-460 6910 / 460 6901

Ireland

GRUNDFOS (Ireland) Ltd.

Unit A, Merrywell Business Park
Ballymount Road Lower

Dublin 12

Phone: +353-1-4089 800
Telefax: +353-1-4089 830

Italy

GRUNDFOS Pompe ltalia S.r.l.

Via Gran Sasso 4

1-20060 Truccazzano (Milano)

Tel.: +39-02-95838112

Telefax: +39-02-95309290 / 95838461

Japan

GRUNDFOS Pumps K.K.
1-2-3, Shin-Miyakoda, Kita-ku
Hamamatsu

431-2103 Japan

Phone: +81 53 428 4760
Telefax: +81 53 428 5005

Korea

GRUNDFOS Pumps Korea Ltd.

6th Floor, Aju Building 679-5
Yeoksam-dong, Kangnam-ku, 135-916
Seoul, Korea

Phone: +82-2-5317 600

Telefax: +82-2-5633 725

Latvia

SIA GRUNDFOS Pumps Latvia
Deglava biznesa centrs

Augusta Deglava iela 60, LV-1035, Riga,
Talr.: + 371 714 9640, 7 149 641
Fakss: + 371 914 9646

Lithuania

GRUNDFOS Pumps UAB
Smolensko g. 6

LT-03201 Vilnius

Tel: + 370 52 395 430
Fax: + 370 52 395 431

Malaysia

GRUNDFOS Pumps Sdn. Bhd.
7 Jalan Peguam U1/25
Glenmarie Industrial Park
40150 Shah Alam

Selangor

Phone: +60-3-5569 2922
Telefax: +60-3-5569 2866

Mexico

Bombas GRUNDFOS de México S.A. de
C.V.

Boulevard TLC No. 15

Parque Industrial Stiva Aeropuerto
Apodaca, N.L. 66600

Phone: +52-81-8144 4000

Telefax: +52-81-8144 4010

Netherlands

GRUNDFOS Netherlands
Veluwezoom 35

1326 AE Almere

Postbus 22015

1302 CA ALMERE

Tel.: +31-88-478 6336

Telefax: +31-88-478 6332
E-mail: info_gnl@grundfos.com

New Zealand

GRUNDFOS Pumps NZ Ltd.
17 Beatrice Tinsley Crescent
North Harbour Industrial Estate
Albany, Auckland

Phone: +64-9-415 3240
Telefax: +64-9-415 3250

Norway

GRUNDFOS Pumper A/S
Stremsveien 344
Postboks 235, Leirdal
N-1011 Oslo

TIf.: +47-22 90 47 00
Telefax: +47-22 32 21 50

Poland

GRUNDFOS Pompy Sp. z 0.0.
ul. Klonowa 23

Baranowo k. Poznania
PL-62-081 Przezmierowo

Tel: (+48-61) 650 13 00

Fax: (+48-61) 650 13 50

Portugal

Bombas GRUNDFOS Portugal, S.A.
Rua Calvet de Magalhaes, 241
Apartado 1079

P-2770-153 Pago de Arcos

Tel.: +351-21-440 76 00

Telefax: +351-21-440 76 90

Romania

GRUNDFOS Pompe Romania SRL
Bd. Biruintei, nr 103

Pantelimon county llfov

Phone: +40 21 200 4100

Telefax: +40 21 200 4101

E-mail: romania@grundfos.ro

Russia

00O lpyHadoc Poccus

yn. WkonbHas, 39-41

Mockea, RU-109544, Russia

Ten. (+7) 495 564-88-00 (495) 737-30-00
dakc (+7) 495 564 8811

E-mail grundfos.moscow@grundfos.com

Serbia

Grundfos Srbija d.o.o.
Omladinskih brigada 90b
11070 Novi Beograd
Phone: +381 11 2258 740
Telefax: +381 11 2281 769
www.rs.grundfos.com

Singapore

GRUNDFOS (Singapore) Pte. Ltd.
25 Jalan Tukang

Singapore 619264

Phone: +65-6681 9688

Telefax: +65-6681 9689

Slovakia

GRUNDFOS s.r.o.
Prievozska 4D

821 09 BRATISLAVA
Phona: +421 2 5020 1426
sk.grundfos.com

Slovenia

GRUNDFOS LJUBLJANA, d.o.o.
Leskoskova 9e, 1122 Ljubljana
Phone: +386 (0) 1 568 06 10
Telefax: +386 (0)1 568 0619
E-mail: tehnika-si@grundfos.com

South Africa

Grundfos (PTY) Ltd.

16 Lascelles Drive, Meadowbrook Estate
1609 Germiston, Johannesburg

Tel.: (+27) 10 248 6000

Fax: (+27) 10 248 6002

E-mail: Igradidge@grundfos.com

Spain

Bombas GRUNDFOS Espafia S.A.
Camino de la Fuentecilla, s/n
E-28110 Algete (Madrid)

Tel.: +34-91-848 8800

Telefax: +34-91-628 0465

Sweden

GRUNDFOS AB

Box 333 (Lunnagardsgatan 6)
431 24 MélIndal

Tel.: +46 31 332 23 000
Telefax: +46 31 331 94 60

Switzerland
GRUNDFOS Pumpen AG
Bruggacherstrasse 10
CH-8117 Fallanden/ZH
Tel.: +41-44-806 8111
Telefax: +41-44-806 8115

Taiwan

GRUNDFOS Pumps (Taiwan) Ltd.
7 Floor, 219 Min-Chuan Road
Taichung, Taiwan, R.O.C.

Phone: +886-4-2305 0868
Telefax: +886-4-2305 0878

Thailand

GRUNDFOS (Thailand) Ltd.

92 Chaloem Phrakiat Rama 9 Road,
Dokmai, Pravej, Bangkok 10250
Phone: +66-2-725 8999

Telefax: +66-2-725 8998

Turkey

GRUNDFOS POMPA San. ve Tic. Ltd. Sti.

Gebze Organize Sanayi Bélgesi
Ihsan dede Caddesi,

2. yol 200. Sokak No. 204
41490 Gebze/ Kocaeli

Phone: +90 - 262-679 7979
Telefax: +90 - 262-679 7905
E-mail: satis@grundfos.com

Ukraine

BisHec LleHTp €Bpona
CronunyHe woce, 103

M. Kuis, 03131, YkpaiHa
TenedoH: (+38 044) 237 04 00
dakc.: (+38 044) 237 04 01
E-mail: ukraine@grundfos.com

United Arab Emirates
GRUNDFOS Gulf Distribution
P.O. Box 16768

Jebel Ali Free Zone

Dubai

Phone: +971-4- 8815 166
Telefax: +971-4-8815 136

United Kingdom
GRUNDFOS Pumps Ltd.
Grovebury Road

Leighton Buzzard/Beds. LU7 4TL
Phone: +44-1525-850000
Telefax: +44-1525-850011

U.S.A.

GRUNDFOS Pumps Corporation
9300 Loiret Blvd.

Lenexa, Kansas 66219

Phone: +1-913-227-3400
Telefax: +1-913-227-3500

Uzbekistan

Grundfos Tashkent, Uzbekistan The
Representative Office of Grundfos
Kazakhstan in Uzbekistan

38a, Oybek street, Tashkent
TenedoH: (+998) 71 150 3290 / 71 150
3291

®dakc: (+998) 71 150 3292

Addresses revised 15.01.2019

Grundfos companies
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99516274 0320
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